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Dear Maya Customer '

Thank you for purchasing the award-winning Maya 6.5, your end-to-end 3D
solution from Alias.

In Maya 6.5, key areas of the software have been re-architected to give you the
level of performance you need to overcome common production bottlenecks.
Regardless of dataset size, Maya now delivers significantly improved interactivity
In areas such as modeling, UV manipulation, deformations and 3D painting. Faster
overall file transfer and a new STEP translator let you quickly import large files
from popular CAD packages. New scene segmentation tools improve large-scene
workflows, while faster shader tuning and final rendering are facilitated through
mental ray for Maya network rendering (Satellite). With so many innovative
solutions for working with massive datasets, Maya 6.5 lets you meet the demands
of your next generation productions. Full details on the enhancements included In
Maya 6.5 can be found in the What's New in Maya 6.5 book, both in print and In
the Maya Relp.

To install Maya 6.5, please refer to the Installation and Licensing Guide included
with your Maya package, which contains step-by-step procedures to ensure proper
installation and licensing. To license a single copy of Maya as a new user, use our
Online Product Activation, which launches when you start Maya for the first time.
I you are registering a floating license, you can use our online SPAR form found at
www.allas.com/spar for product registration.

f you're new to Maya, or just want to brush up your skills, check out the Getting
Started with Maya books, which provide short introductory tutorials on many
important functions within Maya. (New purchases of Maya include printed
versions of these books — online versions are also included in Maya Help for all
purchases.) A wealth of additional learning resources, including additional
Learning Tools and tutorials, can be found at the Alias web site and the Alias
online store.

For additional information on support, maintenance, or the Alias Conductors™

program for third-party extensions, and for the latest news on Alias and Maya,
please visit our web site at www.alias.com.

The Maya development team hopes that Maya 6.5 more than meets your creative
vision. To ensure that Maya meets your future requirements, we welcome your
suggestions and feedback. It you have any questions or suggestions, please feel
free to contact your local Alias representative or reseller, or visit the support
center at the Alias web site at www.alias.com/eng/support/maya/.

sincerely,

Jill Ramsay
senior Product Manager, Maya



WBICUI"E tﬂ Mﬂy3®ﬁ.5 the latest release of the Alias®

award-winning Maya 3D software. To help you find your way around,

we've included this short guide to the Maya 6.5 CDs and documentation.

Maya 6.5 CDs

The Maya package includes these CDs:

Maya Unlimited 6.5 | Maya Complete 6.5

This CD contains all versions of the Maya 6.5 software. Your license will
determine which version of Maya Is installed. CDs are available for all
supported plattorms. You'll also find the Maya Help system, including context-
sensitive help, on the CD. For details about the Maya Help, see the "Viewing
and Printing the Maya Help™ section of this guide.

mental ray® for Maya Satellite

[his CD contains platform-specific versions of mental ray for Maya Satellite,
which supplements the mental ray rendering capabilities in Maya with
additional rendering power provided by networked CPUs. mental ray for Maya
controls the rendering process on the networked computers. For more
information, see the What's New and the online Maya Help.

Maya Documentation, Lessons, and Extras CD

Included on this CD are the printer-friendly PDF files of the Maya 6.5
documentation. As well, the CD provides a number of scene files for the lessons
in Getting Started with Maya and Getting Started with Maya Unlimited. Finally,
this CD contains many extras—scenes, data files, and other material—made
avallable for your use by Alias. The Extras are unsupported. See the readme file
in the Extras directory for detalls.

Maya Help

Ihe comprehensive Maya Help will help you learn and use all aspects of the
software. You can access Maya Help directly from Maya, as well as in PDF
format. Some printed documentation 1s provided In your package, and Is also
available online.

Installation and Licensing Guide for Maya 6.5 (printed and onlinge)
[his guide provides step-by-step procedures for installing and licensing Maya on
all supported platforms, and is also a troubleshooting guide.

What's New in Maya 6.5 (printed and online)

See the What's New in Maya 6.5 manual for complete descriptions of the
features added In the Maya 6.5 release. These features also are described in the
topic-specific books within the online documentation.

Getting Started with Maya

This book provides brief, focused lessons on most areas of Maya Complete. Pick
the features you want to learn and start using Maya right away! New customers
recelve a printed copy of Getting Started with Maya.
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Getting Started with Maya Unlimited

Focused lessons on Maya Unlimited features: Maya Fluid Effects™, Maya Cloth,
Mavya Fur, Maya Live, and Maya Hair. It you purchased Maya Unlimited, your
Maya package includes a printed copy of this book.

Maya Help

A complete online library of guides to virtually every aspect of the software,
including general information about all features of Maya, procedural information
to learn how to perform various tasks, and an extensive reference section.

Maya Release Notes (online)
The Release Notes describe known limitations in the software and ways you can
work around these limitations.

Maya 6.5 Quick Reference Card (printed)
Keep this handy card at your workstation to help you remember the timesaving
shortcuts and hotkeys In Maya.

Viewing and Printing the Maya Help

When you install the software, online help files are also installed. You view the
online help using a supported web browser, such as the Internet Explorer b+,
Netscape® Navigator 7+, or Safari™ web browsers.

The books are also provided in PDF format. You can print the online books using
Adobe® Acrobat® Reader®, available free from Adobe at www.adobe.com.

TO PRINT THE MAYA HELP BOOKS -~ DISPLAYING MAYA HELP
On Windows® or Mac 0S® X operating systems You can display the Maya Help from within

1. Insert the Documentation, Lessons, and Extras CD.  :  Maya by pressing F1 or selecting Help > Maya
2. Navigate to the /pdf directory. - Help. You can go to the following URL to view
3. Double-click to open contents.pdf. the Maya Help when Maya Is not running

This file lists all of the available books. http://localhost:4448/Maya6.5/
4. Click to select the book you want to print. en US/index.html

0. oelect File > Print. |
You may want to create a bookmark to this URL.

On the IRIX® operating system T the help server 1s not running, you won't be
1. Insert the Documentation, Lessons, and Extras CD.  : able to access the URL. To restart the help
2. Start Acrobat Reader and open - server, do one of the following:

/CDROM/pdf/contents.pdf. _ |
To do this, enter the following: e Windows From the Start menu, navigate

cd /CDROM/pdf to the Maya 6.5 program group and choose

acroread contents.pdf View Mava Docs.

3. Click to select the book you want to print. e Mac 0S X Linux. IRIX Start the

4. Select File > Print. documentation server by sourcing in the

startDocServer.sh scriptin the

On the Linux® operating system | |
docs directory under the Maya 6.5 directory.

1. Insert the Documentation, Lessons, and Extras CD. |
2. Start the PDF viewer and open Then open a Web browser and navigate to:

/mnt/cdrom/pdf http://localhost:4448 /Maya6.5/

To do this, enter the following: en_US/index.html
cd /mnt/cdrom/pdf :
xpdf contents.pdf

3. Click to select the book you want to print.
4. Select the print icon.

Context-sensitive help is available
throughout the software. To display information
about a Vlaya tool, click 1ts Help button.

To display information about an option dialog

DOX, use Its Help menu.




The Alias Software License Agreement and the Maya Documentation Server
License Agreement govern use of the Maya software. The full text of these
agreements 1S In the Installation Guide and at www.alias.com/legal.

Alias 1s willing to license the software only to you and only if all of the terms
contained In the license agreements are accepted by you. By Installing and/or
using and/or otherwise accessing the software, you expressly acknowledge and
agree that you are bound by the terms contained in the two license agreements.

- Alias Conductors Program

The Alias Conductors program works with third party developers to support
their creation of plug-in products compatible with the Maya, Studiolools™,
or MotionBuilder® families of software as well as the FBX® file format.

Currently, the Conductors program has in excess of 100 members developing a
wide array of products. In addition to tools compatible with Maya, Studiolools,
MotionBuilder, or FBX, Conductors partners provide market-specific applications
to help optimize production and creativity. A broad range of workflow ang
pipeline enhancing functionalities are available, including motion capture,

data translation, distributed rendering management, crowd simulation,
compositing, middleware, and real time applications.

Image courtesy of Wind Entertainment Ltd.

Image courtesy of Striker 3D, Ltd.

Image courtesy of SAAB Design.



Alias offers three levels of support services to meet the varying needs of Its
Vlaya and Maya Personal Learning Edition customers.

latinum

Maya Platinum Memhership www.allas.com/p

This top-level Membership program lets you maximize your investment in Maya.
For one annual fee you recelive:

e Priority access to all software upgrades and updates

e Unlimited hotline support — 18 hours/day on weekdays
and 12 hours/day on weekends™

e |nteractive Online Case Management™ — track your hotline cases,

reported bugs™™ as well as all your facility’s licensing information and
hot line cases™

e | icensing Flexibility — your Maya license transfers
(same or different operating system) get first priority — at no extra charge

e (One-hour personal training call (until June 30th, 2005

e Alias Insider Technical Solutions and Knowledgebase — online information
on technical 1ssues. workarounds, recommended workflow and more

e \aya Silver Membership — more online learning opportunities (next page)
® And more!

Key Benefits

Unbeatable Value Maya Platinum Membership gives you priority access to all
Vlaya upgrades, unparalleled license relocation flexibility (at no extra charge)
and premium live and online support at an atfordable price. Plus, the fixed
annual fee allows you to better predict and control your costs.

Competitive Advantage Priority access to Maya updates means you can be
the first to use leading-edge Maya features and functionality. Add to this world-
class technical support, and you've got a distinct competitive advantage.

Minimized Down-time Hotline support — with rapid response and resolution
times — Is available 16 hours/day on weekdays and 12 hours/day on weekends™
to help solve your technical issues quickly. Plus, your license relocations (same
or different operating system) get first priority.

Inside Information Maya Platinum Membership gives you access to key
technical information so that you get the most out of your software investment.

Faster Learning Hotline support allows you to be productive taster. Plus,
you can take advantage of the new Platinum Membership personal training
feature™™ ™ (until June 30th, 2005) or discounts on regular training services to
gain experience on Alias software while saving money:.

* Americas, Europe, the Middle East and Africa. For Asia-Pacific support hours, contact your local reseller.
=7 Begins March 2005

T Some restrictions may apply



Maya Silver Membership www.alias.com/silver

The Maya Silver program Is available to customers, students and Maya Personal
Learning tdition users who are ready to start advancing their Maya skills from
the beginner to the intermediate level — or intermediate to advanced. Available
on a monthly or annual subscription-basis, Silver Membership gives you:

e | earning lools movies for

download
e |n-depth tutorials
. . % e
e Real-project-based learning -
- |2
materials e BEL 4 Tal
. . Lo S8 Behind the Screenzi
e [he Maya Mentor interactive, Al e i

learning environment plug-in

Ii.
B

e A textures and shaders database™

e \\eblogs from experienced Maya
users — includes “Duncan’s Corner,” blogs from the man behind

such innovations as Paint tftects
e 30 days of personal assistance using the materials

e A bonus Maya Learning Tools DVD and/or industry magazine subscription
when you sign up

® and more! * Begins February 2005

Key Silver Membership Benefits

Unbeatable Value Maya Silver Membership gives you the tools you need to
advance your Maya skills, and projects, at an affordable monthly or annual price.

Faster Learning As a Maya Silver member you always have easy access to the
resources you need to grow your Maya skills. And because all materials are
efficiently organized on one website, you won't waste valuable time searching
for the tools you need.

Competitive Advantage Use Maya Silver learning resources for professional
development and stay ahead of the competition. Because they are produced
directly through Alias, our learning materials are accurate, relevant and of the
highest quality.

Industry Contacts Membership allows you to become part of a larger
community of 3D software users.

Maya Bronze Membership www.alias.com/bronze

Designed for anyone Interested in Maya, the Bronze Membership program gives
vou Increased access to the Maya community pages of the Alias external
website — at no extra charge. These pages contain Maya learning resources and
iInformation about the sottware.



Alias Professional Services

Alias provides a range of professional services that include:

® workflow re-engineering, to optimize your production pipeline
e creating applications and plug-ins to extend the power of our software

e modifying our software’s source code to add any new features
you might require, or to integrate 1t with other applications

® geveloping customized training programs to increase your artists’
software skills

e architecting custom support options, such as onsite or dedicated
support resources

® and more

Not only 1s Maya 1s used by those creating entertainment content — it is also
increasingly the primary software package of leading designers, illustrators and
graphic artists. Professional Services can help you move from a traditional Z2D-
centric workflow to one where 3D Is used to improve image quality, increase the
reusability of your digital assets, and reduce your costs.

-or more Information about our range of Professional Services and how you can
take advantage of them to enhance your productivity and your bottom line:
www.allas.com/professionalservices

Learning Tools and Training '

Maya Learning Tools www.alias.com/learnmaya

Our wide selection of Alias Learning Tool books and DVDs was developed to put
you on the road to Maya proficiency — or mastery. Learning Tools let you learn
from Maya Product Specialists and CG-industry experts as they share their
production techniques and workflows. And whether you're just beginning to
explore 3D or are looking to improve your speed and efficiency, Alias Learning

Tools — with prices ranging from $19.99 - $129.99 — are an affordable,
accessible option.

Maya MasterClasses™ www.alias.com/masterclasses

-ind out how today's leading-edge effects and animation are
being created, through a Maya MasterClass. MasterClasses
are 90-minute seminars taught by CG-industry experts —
and Maya Product Specialists covering a wide range of ASTERLLASSE:
topics. Each intermediate or advanced level class is focused o

on techniques and workflows that will help you solve specific production challenges.

Maya Certified Training www.alias.com/training

Alias Certified Iraining lets you get hands-on training from an Alias Product
specialist. These short-term, mtense courses will help you improve your skills
quickly; so you can get back to work equipped with the answers you need.



© Copyright 2005 Alias Systems Corp. All rights reserved. Alias, the swirl logo, Can You Imagine, and Maya are registered trademarks and thg Maya
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210 King Street East
Toronto, Ontario Canada M5A 1J7
tel 416.362.9181 | www.alias.com/contact

North America toll free 800.447.2542

EUROPE, MIDDLE EAST & AFRICA
UK, Northern Europe, Middle East & Africa | tel +44.(0)1494.441273
Germany, East & Southeast Europe | tel +49.89.31702-0

 France, Spain and Portugal | tel +33.(0)1.44.92.81.60

italy | tel ++39.039.6340011

ASIA-PACIFIC

Japan | tel +81.0120.765.088

Korea | tel +82.2.6001.3131

Greater China & Taiwan | tel +81.3.5797.3510

South Asia-Pacific | tel +65.6236.2546

www.allas.com

\'s

YO U

SMA-010-0038



	page00-front
	page01
	page02
	page03
	page04
	page05
	page06
	page07
	page08
	page09
	page10
	page11-back

